USING A SPREADSHEET TO RECORD YOUR RESEARCH FINDINGS
BY BoB DAWES

In my pursuit of this hobby | have amassed a large collection of disjointed research information about
each of my family groups. These items range from official statutory registration certificates to handwritten
lists scribbled on memo pads. | have binders, file folders, photocopies, memo pads, loose sheets of
paper, computer print-outs and hundreds of images of documents on my hard-drive not to mention email
messages with genealogical information imbedded in them. How do you manage all of this disparate
information so that you can make sense of it to help in your family history research? My answer to this
dilemma is to use a spreadsheet program.

While most people recognize spreadsheets such as Microsoft Excel and Corel Quattro-Pro as financial
tools most don’t realize their potential as database tools. They are also much easier to learn to use than
their commercial database counterparts such as dBase, Access or Paradox not to mention much
cheaper. If you have an Office Suite or a program such a MS Works then you likely have a spreadsheet
program included in it and if you don’t there are some free versions available such as Star Office and
Open Office. Just Google those names to find them on the web.

Basically, a spreadsheet is a group of rows and columns but its power for genealogists lies in its ability to
sort your data quickly and efficiently. Additional advantages are its printing options and the ability to
transfer a file to your palmtop or laptop computer. Windows CE and Palm OS allow you to transfer Excel
files to a stripped down version carried on your portable computer and in my case this is Pocket Excel.
This means that | can easily take my research with me when | go on field trips.

We address the issue of inputting text data by thinking of fields and records as you would with a
traditional database program. The columns are used for your Field Names and the rows are used for
individual Records. By recording my information into a spreadsheet also means that | can file the
originals and copies away and clear my desk space so | actually have some room to work

In my examples that follow | am using my own Field Names (Column Headings) but you can use anything
you want with more or less detail depending on your requirements. That’s the great advantage about
using a spreadsheet as it’s as flexible as you need and the limit on records to a single sheet is 65,536 so
you won’t run out of space for a while. Even though | could put all of my information into one
spreadsheet, | prefer to divide up my research data geographically. More specifically, Scotland and
Southeast England in my case although you could use family groups as well. Use the [Save As]
command from the file menu to name your spreadsheet as soon as you’ve entered your Field Names.

E3 Microsoft Excel - Scotland Research.xls g@@

E) Fle Edit view Insert Format Took Data Window Help Acrobat & x|
DS SRV $BART o- Rz LA DY E T e e B A |k pom

|
E5 | E
A B [ D E F G H | J K L o

1 SURNAME GIWEN NAMES YEAR EWENT ADDRESS PLACE COUNTY |SOURCE REFERENCE  NOTES BIRTH EVENT DATE SPOUSE/PARENT:
815 GIBSON Robert 1849 Bapt Beith Ayr NAS CH3/1053/9 Outrider 27Mr1849 [10Je1849 s/o GIBSON, Robe
316 KENNEDY Jane Hamilton 1849 Bapt So. Coburgh St Glasgow Lanark GA CH3/770/3 Rope spinner 30Je1849 O01My1853 dfo KENNEDY, Johi
817 | KENNEDY Thomas Hamilton| 1849 Bapt So. Coburgh St Glasgow Lanark GA CH3/770/4 Rope spinner 30Je1849 O1My1853 sfo KENNEDY, Johi
518 GEMMEL Williarm 1850 Bapt Main St Dalry Ayr NAS CH3/1033/4 19De1650 | 23Ja1853 sfo GEMMEL, Willi
819/ JAMIESON Janet Robertson | 1850 Bapt Beith Ayr MNAS CH3/1053/9 Callier 21Je1850 |040c1850 dfo JAMIESON, Jo
520 KINNEDY John 1850 Bapt Burnside Dalry Ayr MNAS CH3/1033/4 13Ap1650 | 21Ap1850 sfo KINNEDY, Lau,
821 SOWAN Jean 1850 Bapt Ltonienoop Glasgow Lanark GA CH3/399/4 Papermaker 20Fe1850 10Mr1850 dfo SOVAN, Willia
822 GARDINER Agnes 1851 Census 33 Castle 5t 5, Edinburgh Midlothian Mitchell HeadAW/47/Linen draper/Beith  ooo1804 ococl851
823 GARDNER Jessie 1851 Death AF Film 170438 04Je1806 |19Mo1851
824 | JAMIESON Janst 1851 Census Beith Ayt EA-FHS 36/ w1815 oooc1851
825 JAMIESON Jean 1851 Census Beith Ayt EA-FHS 1) w1842 ooo1851
526 JAMIESON John 1851 Census Beith Ayt EA-FHS 36/ w1815 w1851
827 | JAMIESON Robert 1851 Census Beith Ayt EA-FHS 16/ w1835 w1851
828 JAMESON William 1851 Census Beith Ayt EA-FHS bf w1845 homox1851
329 LAME Agnes 1851 Census |98 Main St Lochwinnoch |Renfrew  Mitchell | 570/4/pg23-24  Wife/M/47 /Spinners Wife/Beith  xx1804 o851 George LAMB
330 LAME Agnes 1851 Census |98 Main St Lochwinnoch |Renfrew  Mitchell | 570/4/pg23-24  Son/Uf3/ScholarLochwinnoch o848 oco01851
831 LAMBE Andrew 1851 Census |98 Main St Lochwinnoch |Renfrew  Mitchell  |570/4/pg23-24  Son/UA3/ScholarLochwinnoch o838 00001851
832 LAMB Archibald 1851 Census |98 Main St Lochwinnoch |Renfrew  Mitchell | 570/4/pg23-24  Son/UAS/ScholarLochwinnoch o838 w857
833 LAME Christina 1851 Applicant Edinburgh Midlothian GA, M3 CASSILE  Call #D-HEW 1068/ (B) Py 129 xxxx1801 xxxx1851
534 LAMEB David 1851 Census 98 Main St Lochwinnoch  |Renfrew  Mitchell  &70/4/pg23-24  Son/US/ScholarLochwinnoch w1842 | wuxx1851
535 LAMEB George 1851 Census 98 Main St Lochwinnoch  |Renfrew  Mitchell  570/4/pg23-24  Head/MABAWool SpinnerMusse 1805 | xuxx1851 Agnes LAMB
836 LAME Jane L 1851 Census 98 Main St Lochwinnoch |Renfrew  Mitchell | 570//pg23-24  Daw/U20/Millwark erLochwinnoc xxxx 1831 [ooo01851
837 LAMB Mary 1851 Census |98 Main St Lochwinnoch |Renfrew  Mitchell | 570/4/pg23-24  Dauw/UABMillwarker/Lochwinnoc xoooc1835 00001851
335 LAMB Thomas 1851 Census |98 Main St Lochwinnoch |Renfrew  Mitchell | 570/4/pg23-24  Son/UfS/ScholarLochwinnoch o848 oco01851
839 SEWEWRIGHT Agnes 1851 Census  Calton Glasgow Lanark Mitchell |E22-parish 5837 | Dauw/UA3/PLW/Montrose w1838 oooc!851
840 SEMEWRIGHT  Ann 1851 Census  Calton Glasgow Lanark Mitchell |B22-parish 597 Wife/hlidd/Housekeeperlontros e 1807 1851 George SEIWEWRI

The above image is an excerpt from my Scotland Research file and as you can see | have fields for the
following information.
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FIELD NAME FORMAT INFORMATION (examples)

SURNAME Uppercase; () for other spelling Persons surname

GIVEN NAMES Normal case All known given names or initials

YEAR 4 digit year Year of the event being recorded  (Note 1)
EVENT Type of event Birth; Bapt; Death; Marr; Census; Informant
ADDRESS Location of event, if known Street address; Suburb; Church; Farm
PLACE Place of event Town; City; Area

COUNTY County of event County

SOURCE Where the information is from Library; Archives; LDS; FreeBMD
REFERENCE Source details Call/film/batch or library reference numbers
NOTES Additional details about person Occupation; census entries; outrider (Note 2)
BIRTH 8 character format DDMmYYYY | Birth date if known (Note 3)
EVENT DATE 8 character format DDMmYYYY | Event date other than if not birth
SPOUSE/PARENTS | Uppercase surnames Spouse or s/o, d/o for parents (Note 4)
DOCUMENT Source name of document Book, IGl, Directory, Image; OPR Index
FOUND Source of the information 2004 trip; Internet; FamilySearch; Site
LOCATION Your storage information File; Binder; Archival Box (Note 5)
INPUT SEQUENCE 4 digit number Sequence in which data was input (Note 6)
Note 1 While spreadsheets can format dates they don’t like ones earlier than Jan 1, 1980 and especially

don’t deal well with those in the 1800’s and 1700’s so | get around it by entering just the year for
sorting purposes.

| use this field for a variety of additional data such as census information or the occupation of the
individual (separated by slashes). In cases where I've recorded an informant or a witness, | use
this space for their relationship to the primary party. | use the term “outrider” to identify
information that I've collected that doesn’t yet relate to my family.

For both the birth and event dates, | use a personal date shorthand with only 8 characters
(DDMmYYYY eg. 03Ja1861) so Excel won't try to format it as a date. Some spreadsheets will try
to automatically format fields as numbers, text or dates based on their entries and this avoids that
from happening. Where a date is imputed by subtracting the age from the year, as in a census, |
add 4 x’s (xxxx) in front of the year so | know it’s calculated and not actual. For months | use Ja;
Fe; Mr; Ap; My; Je; JI; Au; Se; Oc; No; De and since their letters are all unique they can’t be
confused.

If I know the spouse from a marriage certificate, | enter the name in the usual format of
uppercase surname followed by the given name but in the case of an assumed entry from a
census, | reverse the name sequence and put the given name first. Parents are preceded by s/o
or d/o to indicate them as a child of and their sex.

Since we’re doing this to clear up our work space it's important to identify where to find the
information if you need to refer to it again for verification. If I've taken something off the web and
not printed it out | note that fact here along with the web URL.

Usually you will enter your data in logical groups after a research trip. This information can be
important so | added this field that allows me to sort my entries back into the sequence they were
when | entered them. This also keeps family groups together from census entries.

Note 2

Note 3

Note 4

Note 5

Note 6

The great advantage of using something as flexible as a spreadsheet is that you can add or change
whatever you want. Your field name requirements may be different from mine so use the ones that make
sense to you. If you discover that you need a new field for additional information then simply highlight the
column to the right of where you want it and use the [Insert Column] command to create a new one. If
you are inputting repeated information such as the address, place & county from a census, use the copy
and paste utility to save keystrokes. Click on the borders between columns to readjust their width to fit
the content which will change as you add more information and use the freeze frames option to lock your
field names in place at the top of the screen otherwise they’ll scroll up and you can’t keep track of which
field you're entering. Freezing is done by placing your cursor in cell B-1 and selecting [Freeze Frames]
from the Window menu. Finally and most importantly, save your work often by pressing <CTRL> + S or
clicking the save icon. Alternately, you can set a timed, automatic save like Word Processors have but by
default this is turned off in spreadsheet programs.

Now that you’ve collected your data lets look at using it. The easiest feature to use is the sort utility found
under the Tools Menu in Excel. Before sorting make sure you've saved your file and then highlight the
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sort area by placing your cursor in cell A-1, use <CTRL> + <HOME> to get there from anywhere in the
spreadsheet. Next, hold your Control and Shift keys down while pressing END to highlight the entire data
portion of your spreadsheet. Don’t leave any blank lines in your spreadsheet or this won’t work so make
sure that your field names row and your data records are all contiguous. Now select the Data — Sort
function from the menu bar at the top of the screen.

The sort function should pick up that you've got a Header Row but if it  [558 @@
doesn’t click the appropriate Radio Button on the dialogue box to the

right. Sorting can be done in three levels and my favourite is by Year | * P

and then Surname and Given Name. Clicking the down arrow in - | S‘Z:z:n:iig
each sort criteria window will display a list of your field names. When Tz g -

you’'ve got the sort criteria set up the way you want press <OK> and [SORMAME <] © Ascendig

your data is re-ordered for you. To get back to the order you had ™ Descending
before starting, just use your Input Sequence field as a single criteria Then by

and you're back since it started at number one and increased with GIVEM NAMES ; "‘“e”d‘i‘_g

each record you entered in the sequence that you used. — bescendng

The first thing | do after sorting like this is to scroll through my data * Hesdertow - Hoheaderrou
looking for duplicates that I've entered since there are times I've options..._ | [k | canca |
copied information | had already gathered or two sources have the

same material like FreeBMD and 18370nline. These redundant rows can be quickly deleted to reduce
the size of your spreadsheet.

My only caution when sorting is to remember to highlight your entire data area before doing so or you will
sort only part of your spreadsheet making it useless and unless you use UNDO <CTRL >+ Z right away it
will be difficult to fix. For this reason, | make a duplicate copy of my master spreadsheet and save it
under a different name using the [Save As] Command before | mess with it. Add the word “master” to the
file name you select so you can differentiate it from your working copy.

Finally, if you want to use a form to enter your data or to do quick and easy searches, place your cursor in
the Home Cell (A-1) again and select Form from the Data Menu. You should see the following dialogue
window where you can either enter, correct or search for information.

Sheet1 [AL3] To search, select the Criteria Button and enter
SURNAME: [Lare o]  z190f 1206 the required date in the appropriate field and
GIVENWAMES:  [George Hew then click Find Next. Your entry that
VEAR: [1504 e corresponds to the criteria will be shown and
EVENT: [Eith L using Find Next again will cycle through all of
ADCRESS: [Trweresk the ones that match if there are more than
PLACE: |Muss|eburgh M one.
COUNTY; [Midiothian - ) o
e ES Crieria To enter additional data either fill in the
REFERENCE:  [Feel 63973 Fr 3052 o appropriate field on an existing record or click
NOTES: [eopt To3ere07 - the New button to clear all fields. If you prefer
—_— [fioos to use a form for entering your data, just enter
s [ENE your Fieldnames on the first row of the
SPOLISE/PARENTS: [LAMB, Gearge & KENNEDY, Mary spre_adsheet and then ple the Form OptIOI'I to
e e v oo use it. Use the <TAB> key to move through
FOUND: o T your form as you would the spreadsheet.
LOCATION: [originals

| also use spreadsheets to catalogue all of my
Input Seq: |961 j . . N J

certificates and original copies or images and

to record extractions from the1861 Sussex census. The possibilities are endless but we’ll leave those for
another article. Enjoy your research!
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